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WHAT WE LOOK FOR IN APPLICANTS

Truman is a high-trust impact community for national security leaders. We develop timely, innovative,
and principled solutions to preserve and expand democracy, human rights, prosperity, and security
worldwide. We draw on our nationwide membership’s intellectual firepower, national security
experience, and extensive personal networks to do the work required for lasting change.

Competitive applicants embody the character traits and values essential to building the ties and trust
that define a strong community. We look for people with honesty, integrity, humility, and a desire to
serve others before themselves. Strong applicants aspire to leadership in national security and global
affairs by leveraging their expertise in policy, politics, or hard security, whether in or out of government.
Our diverse membership includes Hill staff, military personnel, veterans, federal employees, intelligence
community members, non-profit leaders, academics, industry leaders, political strategists, and elected
officials across federal, state, and local government. We look for individuals who understand the
importance of collaboration with others whose strengths complement their own. Qualifying experience
may be reflected through your:

Policy expertise in academia, government institutions, non-profits, or law;

On-the-ground experience from military service, global health, or humanitarian work;

Hard security expertise from defense contracting, intelligence, or operations;

Political expertise from campaigns, fundraising, elected office, or grassroots organizing;

Experience teaching progressive candidates, activists, voters, college students or other citizens
to improve their ability to understand national security issues;

Communications expertise from consulting, speechwriting, writing in ways that shape the
engagement of non-foreign policy experts on national security issues, or working in the press.

We look for individuals who will execute our mission to unite and equip a diverse community of
American leaders to produce timely, innovative, and principled solutions to complex national security
challenges. We envision an inclusive foreign policy that improves American lives by advancing democracy,
human rights, prosperity, and security at home and abroad.

Lastly, we look for individuals who will uphold our values:

Do work that matters. Be ambitious, tackle worthy problems, and have a theory of alignment with

our goals for national security, leadership, or both.

Protect the torch. Do your diligence, working only with people and organizations we can be proud

of. Conduct your work as a professional with the highest content, form, and delivery standards.

Every Truman member is an Ambassador of this organization and its members.

Protect the community. Look within the Truman community for help; it’s here. In return, help

when asked if you’re in a position to do so. Treat each other with respect.

Lift up and make room for others. Share the mic, be inclusive, and offer even strong opinions in a
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way that will leave others comfortable sharing their own.

Assume and model good faith. Engage with the most generous interpretation of others’ speaking

and writing. Ask clarifying questions if any other interpretation seems plausible. Think about an

issue from the other person’s perspective before you write or speak.

Set the standard for professionalism and principle. Be on your best behavior. Ask what the

community would be like if everyone comported themselves honorably. We are what our habits

make us.

Live gratefully. Say thanks and give thanks. Let folks know when they did something you

appreciate.

Elevate diverse voices. Truman National Security Project seeks to expand the diversity of

Americans contributing to every level of the U.S. national security and foreign policy community.

We are dedicated to advancing Diversity, Equity, Inclusion, and Justice (DEIJ) as a national security

imperative. Truman condemns white nationalism and white supremacy. Racism is a threat to the

social fabric of the United States and is an important national security issue that degrades

American democracy and the vitality and credibility of U.S. global leadership. Truman strives to be

a diverse and inclusive organization in recruiting members and staff and elevating diverse voices in

our work.
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APPLICANT ELIGIBILITY

Please check your eligibility before you apply. You must:
Submit your completed application by the deadline of 11:59pm PST, August 23, 2023.

Be a U.S. citizen of at least 21 years of age (there is no maximum age limit).

Attend the virtual interview if selected.

If extended an invitation to membership, attend virtual orientation and the annual Truman

Conference (TruCon). Please do not apply unless you can commit to attending orientation and

TruCon.

Affirm the values of the Truman community (see Truman Values Statement in the FAQ section

below or on our website).

Truman members have many ways of engaging in the public square, some of them partisan. The Truman

National Security Project is a 501(c)4 membership organization. Some organizations may forbid you to

participate in Truman. We ask that all applicants certify they can participate in Truman if selected. If you

have doubts, please reach out to ask or consider whether next year would be a better time.

Membership Cohorts

Cohort membership helps us to ensure that our incoming class includes the ranges of experience that

help us to effect change. It also signals to other community members where your primary expertise lies.

All members receive the same rights and privileges regardless of the Cohort through which they join

Truman.

Security Fellows are policy experts, academics, and other thought leaders who anticipate and

articulate new global challenges and opportunities. Many work within the U.S. national security

apparatus, legislative bodies, the international community, and an expansive network of

nongovernmental and private organizations.

Political Partners are political leaders, advocates, communicators, journalists, and aspiring or actively

serving public officials. Fluent in campaign management, media, journalism, organizing, and more,

they advance progressive principles and a shared liberal internationalist worldview at all levels of civil

society.

Defense Council members include veterans and frontline civilians who have firsthand experience

implementing U.S. foreign policy. They have wide-ranging expertise in hard security and an ongoing

professional interest in defense and intelligence operations as they continue to serve in government,

business, policy, and nonprofit ventures.
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FIRST-YEAR REQUIREMENTS

Truman is more than a loose collection of individuals. We unite as a tight-knit community to build and lead.

To that end, we require all members to participate actively in their first year. Please ensure you can fulfill

these requirements before applying.

Pay annual membership dues. Introductory dues are $350, and renewals are $250.*

Attend virtual orientation tentatively scheduled for February 9-10, 2024.

Attend virtual membership training sessions throughout the year.

Attend TruCon, Truman's annual in-person conference in Washington, D.C., typically held in early

June. TruCon tickets typically cost $250.

Participate in the new members' mentorship program.

Participate regularly in chapter events to foster a strong and trusted community.

As problem-solvers in a gratitude-powered organization, we ask new members to support

community efforts well and/or often enough to earn thanks from three staff or senior members.

*We work hard to ensure the ability to pay application and membership fees does not affect candidates'

or members' participation in Truman. If you are concerned about the cost, please contact

membership@trumanproject.org about financing options.
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APPLICATION COMPONENTS AND TIMELINE

APPLICATIONS OPEN - WEDNESDAY, JULY 12TH, 2023

VIRTUAL OPEN HOUSE I - TUESDAY, JULY 18TH, 2023, 7:00 PM ET

VIRTUAL OPEN HOUSE II - TUESDAY, AUGUST 1ST, 2023, 9:00 PM ET

VIRTUAL OPEN HOUSE III - AUGUST 15, 2023, 8:00 PM ET

APPLICATIONS CLOSE - WEDNESDAY, AUGUST 23RD, 2023 (11:59 PM PT)

The questions we ask in the application allow us an opportunity to learn more about you. You might find

that we ask a bit more than other programs. You’ll also find that we try to go above and beyond to create an

exceptional community of leaders - and that starts with our attention to detail during the selection process.

In this application, you will be asked for:

$50 application fee

Basic demographic information (optional)

Three essay questions (approx. 400 - 450 words each)

Cover letter

Résumé/CV

Biography (500 Word Max)

Two letters of recommendation

Links to additional materials (media appearances, publications, Linkedin Page, personal website or

project page, etc.)

You will have the option to save and continue your application. Incomplete and/or late applications will

not be considered. You will receive a receipt by email for the application and your $50 application fee.

Questions may be directed to membership@trumanproject.org.
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STRATEGIC PRIORITIES & ESSAY RESPONSES

Your answers to the essay questions are a critical component of your application, so be sure to write

thoughtful responses. Writing a relatively short answer (400-450 words) can be challenging! Be sure to

consider how your responses align with our strategic priorities, captured in the image below:
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Essay questions

So that you can begin preparing, we’ve included the essay questions (responses should be between 400

and 450 words each) in this application guide:

1. How would becoming a member of the Truman National Security Project empower you to tackle

worthy problems, and in what ways do your priorities align with our strategic priorities?

2. Share an example of when you passed the mic or otherwise acted to promote diversity, equity,

inclusion, and justice (DEIJ). Why did it matter? How do you envision supporting DEIJ as a member of

Truman? What is a blindspot in your own DEIJ education where you’d like to do additional learning?

3. Under what circumstances should the U.S. be willing to sacrifice human rights in the name of

security?

Attachments

Applicants will be asked to upload responses to the essay questions with their application materials in a

single doc, docx. or pdf file.

How to merge your materials in a single pdf file:

For Windows: Visit the Adobe website and use their merger tool directly on your browser. OR use a

reliable third-party merger application such as PDF Merger & Splitter to merge your document.

For Mac:

1. Open a PDF in Preview.

2. Choose View > Thumbnails to show page thumbnails in the sidebar.

3. Select a page thumbnail to indicate where to insert the other document.

4. Choose Edit > Insert > Page from File.

5. From the file dialog, select the PDF that you want to add, then click Open.

6. To save, choose File > Export as PDF. For more information, read here.

You can also use your computer’s “screenshot” or “screen capture” function, then upload the image

saved into a Word or Google document. You can then save the document “File>Save as a PDF”.

Deadline for Applications: Wednesday, August 23rd, 2023, at 11:59 PM Pacific time

Questions may be directed to membership@trumanproject.org.
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FREQUENTLY ASKED QUESTIONS

1. How long does the application take to complete?

Completion time will vary depending on how long it takes to acquire your letters of recommendation

and complete your essays. Excluding letters, your Truman application can take between 2-5 hours. Take

your time with your application to submit thoughtful essays and robust letters of recommendation. You

will have the option to save and continue your application. Incomplete and/or late applications will not

be considered.

2. What if I am qualified to apply to multiple cohort categories?

Many applicants find that their strengths fit into more than one membership cohort. When deciding

to which cohort you will apply, consider the following:

➔ At a social gathering, what kind of people do you gravitate towards?

➔ What kind of outlets regularly publish work that you find interesting?

➔ What unique perspective do you bring to solving national security and global affairs issues?

If your answers were most tactically focused with an eye towards operations and on-the-ground

experience, Defense Council sounds right for you. If you focus more on up-to-the-minute updates on

elections inside and outside the Beltway, the Political Partnership is up your alley. If you enjoy

in-the-weeds analysis of policy and history along with pragmatic and well-researched points, then the

Security Fellowship may be the way to go.

Whichever you choose, know that you may be considered for the others. Know, too, that all members,

regardless of cohort, attend the same Orientation and are accorded the same rights and privileges as

Truman members.

3. What do I do if I can’t make the orientation date?

A: If you already know that your schedule will not allow you to attend orientation, please wait to apply

until next year. Full attendance at orientation is required.

4. If I am on active duty or in a Hatch or Super Hatch position, can I still apply?

The Truman National Security Project is a legal 501(c)(4), and membership dues are considered a

donation to a 501(c)(4). Active duty military, Hatch, and Super Hatch individuals are welcome to apply.

However, we recommend that individuals check with their organizations’ legal authority first.
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5. What should I know about membership fees?

Membership Dues are $350 during the associate year and $250 in subsequent years. Fees cover

orientation, workshops, onboarding resources, and a host of other forthcoming features in addition to

regular membership resources ranging from op-ed writing and support to access to jobs, opportunities,

community listservs, and events. We don’t want financial need to hold anyone back from applying to the

membership and have payment plans and other resources available. Contact

membership@trumanproject.org with any concerns regarding dues.

6. I submitted my application and realized I have additional information I would like to provide (new

job, additional publications etc), What do I do?

You can access your application until the deadline to make changes or additions. Incomplete, late

applications or additional documents will not be considered past the deadline.

7. Am I a competitive applicant?

The Truman membership is a nationally competitive program that accepts approximately 100 total new

members a year. We strongly suggest you attend one of our virtual open houses to assess the strength

of your application.

Didn’t find the answer to your question? Email us at membership@trumanproject.org.
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STEP-BY-STEP APPLICATION GUIDE

This step-by-step guide will provide you with screenshots of what to expect as you progress through the 2024 Truman

Membership Application.

You will find the New Member Application through this link. On this page, you will see the new member application

details before you begin your application. You can select “Read More” on the right-hand side to access additional

details, such as application requirements, membership requirements, and other pertinent details. If you need

assistance with your application or an accommodation to complete the application, please contact

membership@trumanproject.org.
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The application has multiple steps and automatically saves your work as you proceed. You may return to your draft

application through the same link and continue your work at any time. Please note that incomplete or unsubmitted

applications will not be able to be reviewed by the selection committee, and applications will not be accepted after

11:59 PM PT on August 23, 2023.
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SECTION 1

The first section of the application begins with standard contact information, such as name, email, phone number,

address, preferred name, social media handles, voluntary demographic information, and professional/employment

affiliations. This information will be retained, should you be selected as a member, for billing information, chapter

designation, and to aid staff in reporting out the demographic makeup of the 2024 Cohort and Truman members as a

whole.
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After completing this first section, you may return and edit information until you submit your final application. You

may also move on to work on the next section by clicking the “Next Step” button.
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SECTION 2

The next section will explain the requirements of each member, eligibility to become a member, the Truman Values

Statement, your membership cohort preference, and a deeper dive into your credentials, your experience, and your

motivation for applying to join the Truman National Security Project. There will be additional questions, and a portion

asking you to upload, in one file, your application materials. This upload should include your cover letter, resume/CV,

essay question responses, and up to two letters of recommendation.
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MEMBERSHIP DIRECTORY

Truman is a high-trust impact community for national security leaders. We develop timely, innovative, and principled
solutions to preserve and expand democracy, human rights, prosperity, and security worldwide. We draw on our
nationwide membership’s intellectual firepower, national security experience, and extensive personal networks to do
the work required for lasting change.

In order to foster collaboration to achieve the above together, we have a vast and robust membership directory that

enables members to work across cohorts to achieve our common goals. That being said, some members are unable to

be listed in our membership directory due to the confidential nature of their roles. We hope you will be able to join

our member director, though we respect our membership needs and will respect any requests to not be listed in our

membership directory.
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A key facet to membership is aligning cohorts working within one of our three areas: Security Fellows, Political

Partners, and Defense Council. Please read through the definition of each to ascertain the best fit for your

membership.
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Membership selection is conducted by our membership population. This information will help the National Selection

Committee understand your path to membership and how it aligns with our overarching goals of having a class

representative of the United States.
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The final component of the selection process is to write a response to the essay questions and combine materials

together in one PDF document to complete your application package. In this, we request a cover letter that will be

read to understand your motivations for applying to join the Truman National Security Project, a resume/CV to outline

how your career path led you here, your responses to the three essay questions listed below, and up to two letters of

recommendation.

A successful cover letter should include information that is not captured elsewhere in your application materials. This

might be details on volunteer work you do in a national security realm, or speaking engagements in public forums that

are not reflected in your resume. In short, the cover letter is your opportunity to share details about how your

experiences qualify you as a potential candidate from Truman membership in your own words, in ways that your

résumé/CV, letters of recommendation, and essay question responses do not provide.
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Once you upload your application package, you will be directed to the payment screen for your application fee.
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SECTION 3

The next section allows you to fill in payment details to pay your application fee. Please note that ACH payments are

preferred, as they incur significantly fewer costs to process, thus providing more available funds for Truman-sponsored

events.
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Once you submit your payment information, you will come to a confirmation screen with the opportunity to create a

login password.
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Upon, submitting your application, please be sure that all of your materials in your application packet are accurate and

complete. Once you submit your application, you will not be able to edit your application packet. If you have any

issues with your submission, please email membership@trumanproject.org

Congratulations! You have completed the application process. The application window closes at 11:59 PM on August

23, 2023. Applicants selected for interviews will be notified the last week of September. Applicants selected as Truman

members will be notified the third week in November. We will contact you via the email address you provided in the

application process.
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